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Section 1: Sample Preparation for microCT 
 

1.1 Necessary Materials (00:14) 

● SCANCO microCT 50 
● 6cm Petri dish (60 x 15 mm) 
● 2% Concentrated Agarose 
● Reference Piece (Wooden) 
● Thermometer 
● Pipette 
● Razor blade 
● Weigh-boat Spatula 
● Forceps 
● SCANCO Specimen Tube w/ Lid 
● Removal Button 
● Sample Measurement Block 
● Pusher Rod (Not displayed in Figure 1) 

*Note: If your samples are prepared, please skip to Section 2 or 04:33 in [YouTube Link]. 

  

Figure 1: Image of all the 
necessary materials for proper 
use of the microCT 50. 
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1.2 Preparation Steps (00:24) 

1. Warm up the microCT machine by running the “SC” program on the “Scanning/Analysis” computer. 

(Computers have labels on the shelf above the monitor). A new window will appear, and your mouse 

cursor will convert into a blue, loading circle. Please let this load. If another mini-window appears with 
a NOT ready message, please wait the usual time of ~15min for the machine to ready/warm up. Once 

warm, a small window will appear asking, “Do you want to start a measurement?” Click “Yes” ONLY 

once you have completed Sections 1 AND 2! 

2. Acquire your SCANCO Specimen tube(s) and the removal button(s). Place ONLY one removal button at 

the bottom of each tube with the wires facing upward (buttons do not have to be flat). Place the tube 

on the Sample Measurement Block and keep this for later use. The Sample Measurement Block is used 

to prevent any unwanted movement of the specimen tube. *Note: A maximum of 11 tubes may be 
used per scan. DO NOT TAKE SPECIMEN TUBES OUTSIDE OF WORKSTATION ROOM!!! 

3. Microwave a jar of agarose for as long as needed to liquefy it (recommended time is one minute). Put 

agar to the side until it is cool enough to be comfortably held in one’s hand without burning (about 
38ºC using the PROVIDED thermometer). If the agar used to load the samples is too hot, you risk 

cooking the sample and disrupting any histological analysis. *If no jar of agarose is available, add 90.5 

mL of water to 1.5 g of agarose powder and boil using a microwave/hot plate until the solution is 

transparent. 

4. If the agar must be cooled quicker, take the jar of agar and place it in a cold-water bath. Check the jar’s 

temperature frequently to ensure the jar is about 38ºC. Once the agar has cooled to the temperature 

listed in Step 3, pipet the warm agar from the jar onto a petri dish/plate to form a base layer. Allow this 

layer to cool until firm. 

1.3 Creating Your Bone-Agar Block(s) (00:58) 

READ STEPS 5-9 BEFORE CONTINUING! 
5. Place your bones on the base layer of agar from left to right ensuring the proximal and distal ends are 

vertical and close enough to each other to fit inside the specimen tubes. The larger specimen tubes 

(19mm) require your stack of bones to be placed within a 16.70mm diameter while the smaller 

specimen tubes (14mm) require 12.00mm. As seen in Figure 2 below, both Petri dishes can be used as 

they are within the listed margins. 
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6. The proximal orientation of the bones in the stack can either be facing up or down, however, ALL 

bones must be in a consistent orientation to ensure an accurate analysis. When creating your stack, try 

to align the midpoints of the bones with each other.  

*Note: Up to 5 bones and a reference (total 6), which is a piece of wood of similar dimensions to the 
bone (labeled in Figure 3 below), can be included per petri dish for the smaller tubes. Although 

discouraged, it is possible to have more than 5 bones per petri dish if using the larger tubes. 

 
 

 

 

 
 

 

 
7. For each petri dish used, it is STRONGLY recommended to create an illustration (on paper or digital) of 

your bones in the petri dish to keep track of them. We encourage users to use the Standard 

Arrangement uCT50 Scanning Parameters template. Please see the lab manager if you are having 

trouble mapping your bones. 

8. For each layer of bones in the stack, pour a layer of agar to create a “barrier” between each layer of 

bones. For the conventional stack of bones (5 bones and the reference): a base layer of agar, a layer 

with your first set of bones and agar, and a layer with your second set of bones along with the wooden 

reference piece and agar. Be sure to let each layer of agar cool (not until solidified) to allow for the 

separation of layers (usually 15 seconds).  

*Note: The wood will serve as a fiducial marker to help locate which bone is where in the scan. 

Figure 2: Depicts large (left) vs. small 
tube (right) sizes and inner diameter 
length of Petri dishes used in a previous 
experiment. 

Figure 3: Bird’s eye view of a petri dish with 
the second layer of 3 bones (left) and fiducial 
marker in the agar-bone block with 
conventional bone stack (right). 

https://bpb-us-w2.wpmucdn.com/sites.wustl.edu/dist/f/1982/files/2021/08/MRC_FORM_Standard_arrangement_uCT50_scan_parameters.pdf
https://bpb-us-w2.wpmucdn.com/sites.wustl.edu/dist/f/1982/files/2021/08/MRC_FORM_Standard_arrangement_uCT50_scan_parameters.pdf
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9. Finally, fill the petri dish with agar to the top and wait until this has cooled and solidified. 

1.4 Using Your Agar-Bone Block(s) (02:53) 

10. After the agar in the petri dish has cooled, using a razor blade, CUT out the bones in a singular 

agar/bone block as seen in Figure 3 above (this will now be referred to as the “Agar-Bone block”). 

Always cut out the agar-bone block with excess agar so it can be trimmed off if necessary. Return the 

excess agar in the petri dish that has NOT touched the bones/wood into the agar jar for future use, and 

be sure to microwave this jar to melt the solid agar back into the liquid phase.  

11. Before continuing, ensure a removal button sits at the bottom of each specimen tube, which should 

have been completed in Step 2 of 1.2 Preparation Steps. 
12. Take your Agar-Bone block(s) out of the petri dish using the weigh-boat spatula and place it (with the 

desired orientation) in the specimen tube (usually distal first). If it does not fit, trim the edges of the 

block such that it will fit; however, be sure the Agar-Bone block will fit “snugly” when placed in the 

tube.  
13. Push the Agar-Bone block down the tube (~5cm from the top) with a pushing rod (refer to Figure 4) 

and firmly cap it with one of the tube lids, ensuring the removal button’s wires are NOT protruding. If 

you are experiencing difficulties, please review the video tutorial before requesting help from the Lab 
Manager. 

14. REPEAT all of Section 1: Sample Preparation for microCT for EACH petri dish/tube. 

 

  

Figure 4: Image of “Pushing Rod.” 
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Section 2: Loading the microCT 
 

2.1 Sample Loading (04:33) 

1. Once your tubs are capped, you may place them into the microCT 50 in whatever numbering system 

you prefer AFTER reading Steps 2-5. *Place these tubes in the microCT as demonstrated at 04:33 in our 

YouTube video. 

2. Before loading any new samples, check if the microCT door is open. The digital screen on the microCT 

will say “READY TO SCAN” if the machine is ready. Otherwise, it will appear identical to Figure 5, 

indicating a scan is in progress, and the door is locked. Please ensure the time you have reserved is 

correct. Do NOT use the key to unlock/lock the door! 

 

 
 
 
 
 
 
 
 

3. Lift the door of the microCT carefully and insert your tube(s) into one of the 12 positions on the 

carousel, orienting the flat side of the metal base so it is in contact with the flat side of the dodecagon 

on top of the carousel. 
4. If you’re loading more than one tube onto the carousel at once, be sure to keep track of which tube 

corresponds to what bones are present to prevent confusion during analysis! We encourage you to 

place the numbered tubes in their respective position in the carousel.  
WARNING: The microCT 50 must always have at least one vacant position on the carousel in the 

event of an emergency. NEVER load more than 11 samples at a time. 

5. Once all samples are loaded, gently close the door and return to the “SCANCO Scanning/Analysis 

Computer.” Click “Yes” as mentioned in Section 1.2. Wait for the blue loading circle to morph back into 

the usual mouse cursor. 

  

Figure 5: Image of microCT 50 status 
screen while a scan is in progress. 
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Section 3: Starting a New Experiment 
 
3.1 Preparation of the ScoutView Scan(s) (05:07) 

It is strongly encouraged that you follow along with the video for Section 3! 
1. After clicking “Yes” in the previous step, another window will appear for you to enter your Sample 

Number. Enter the number that was provided by the Lab Manager. 

2. It is strongly encouraged to clear the “Tasks” list before continuing to prevent confusion later on. Clear 

ALL previous tasks by clicking the “Task List…” and then clicking “Clear List” (refer to Figure 7). In some 

cases, after clearing tasks, your Sample Number may change. If this occurs, click “Other…” and re-
enter your sample number. 

3. Next, select your carousel position based on the tube placement (Figure 6). Be sure to know what’s in 

what tube and what tube is in what carousel position BEFORE continuing (refer to Step 7 of Section 

1.3). For your first tube, select its carousel position. (ie. if you have a tube in position one, select the 
round “1” button at the top). 

4. In addition to the sample number, your Lab 

Manager will provide a "Controlfile.” To locate 

the Controlfile, you can apply a filter by 
searching for it in the "Filters:" section. Once 

you find your Controlfile, click on it, and then 

click "Add Scout." Repeat steps 3 and 4 for 

each tube present. (Click “Ok” on the window 

that appears after each “Add Scout”). 

  

Figure 6: Screenshot of “SC” window 
depicting Sample #, Controlfile, etc. 
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5. Once all of your tubes have been added, click on “Task List…,” click your FIRST task, and then click 
“Start Interact. Tasks” at the bottom of the window. DO NOT repeat Step 5 for each tube. Remember, 
only a maximum of 11 tubes should be running at a time.  

6. Please wait until this process is complete, which will be denoted once ALL task(s) in the "Task List" 
window change from "Pending" to "Done." *Note: The scan for each tube placed into the microCT 
typically takes 2-3 minutes. (ie. Four tubes can take 8-12 minutes). 

 
 

 
 
 
 
 
 

 
3.2 Preparation of the CT Scan(s) (06:14) 

It is strongly encouraged that you follow along with the video for this subsection! 
7. After the scan is complete, an image of your Scout View will appear in the top right of the 

“ScanProgram” window. Click on a ScoutView in the “Tasks” window and then click “Load Scout.”  

READ STEPS 8-10 BEFORE CONTINUING! 
8. Click on "Reference Line" (may be hidden behind the “Tasks” window), which allows you to create a 

measurement reference for the length of the bones. Move your cursor back onto the ScoutView. 
Green-colored reference markers should appear. If your ScoutView does not display the entire Agar-

Bone block with your bones, please see the Lab Manager to adjust the size of your Start and End 

positions.  

9. IF you’d like to zoom in/out or translate the ScoutView, click anywhere on the ScoutView. Use your 

mouse's scroll wheel while hovering over the ScoutView for zooming. For translations, hold the right-

click button and drag the mouse around. Once you are satisfied with the zoom and translation(s), click 

“Reference Line” again and continue to Step 10.  

  

Figure 7: Screenshot of the 
“Tasks” window. 
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10. When hovering over the ScoutView, hold the shift key to lock the top of your reference marker. While 

the shift key is held, move the mouse vertically up or down to adjust the length of your reference. The 

length should cover the entirety of your bone of interest. Once satisfied, left-click to lock the 

measurement reference in place. Refer to Figure 8 for help.  

*At the bottom of this reference, in green text, the program will state the number of slices to be 

scanned and provide an estimated scan time in hours. 

11. Finally, at the bottom-middle of the “Scout-View…” window, click “Add Scan.” Repeat steps 7-11 for 

each tube placed into the microCT. A new CT-scan task will appear (one for each tube). You may move 
the “Scout-View…” and “Tasks” windows by left clicking and dragging the headers around. 

12. Once ALL tasks have a measurement reference and have been added, click “Submit Batch Scans” at the 

bottom of the “Tasks” window (refer to Figure 7). After about one minute, ALL of the windows will 
disappear. This indicates the scan is in progress and you may now temporarily leave and return when 

your scan is complete.  

*Note: It is recommended to set a timer for your scan such that your samples can be removed in a 
timely manner and the microCT machine can be ready for the next user. This is the same time as ALL of 

your scans added together. 
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3.3 Disposal of Leftover Agar 

13. Once the scan is complete, you may open the door of the microCT and remove your tubes.  

 

14. Uncap the specimen tube lids → CAREFULLY cut/squeeze out the bones from the Agar-Bone block 

using either your fingers or a razor blade while keeping track of which specimen is which. 
Contaminated agar and foam (if used) should be appropriately disposed of in your lab. Lastly, you may 

keep the bones for future use, and the wooden reference marker may be preserved or thrown away. 

***Please be sure to return any used shared-equipment back to its respective place. 

  

Figure 8: Screenshot of ScoutView w/ locked Reference Marker. 
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Section 4: Analyzing Your Scans 
 

4.1 Retrieving & Loading Your Scan(s) (08:09) 

It is strongly encouraged to follow along with the video for Section 4! 
1. To retrieve your microCT 50 scanned images, use the “µCT50 Analysis Computer” (there are two) to 

locate a window called “SCANCO Application Center.” If this tab is not already open or the computer is 

asleep/off, wake the computer and double-click the application labeled “AC” on the desktop screen. 

*Use the password provided by the Lab Manager to access the software.  

2. Once the "Application Center" has finished loading, click the "Ev" button to open the "Evaluation" 

window. A new mini-window titled "Load Image From Server" will appear. If you have a specific 

measurement number, select it from the drop-down menu labeled "Samples.” 

3. If you do NOT have a measurement number or could NOT find your folder in the drop-down menu, it 

may be located amongst all the samples. *To view all samples, ensure “All” is selected from the drop-

down menu. Scroll through the samples list below or search for the name of your folder in the white 

text box next to “Filters:”. *If you are unable to find your named folder, please consult the Lab 

Manager.  

4. Once you have located your respective data folder and left-clicked on it, a list of measurements will 

appear on the right in the “Measurements” box as seen in Figure 9. 

  

Figure 9: Screenshot taken from the “Load 
Image From Server” window depicting a 
Measurement and Evaluation Group 
selection. 
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5. Each of these measurements is a .ISQ image file, which can be accessed by double left-clicking on any 

of them, or by clicking on the measurement once, and clicking on it again in the box below as shown at 

(08:22) in the video tutorial. 

4.2 Subvolumes & Grouping (08:35) 

6. Load your measurement via “File” → “Load Image From Server” → navigate to the “Tasks” tab of the 

SCANCO “Evaluation” (Ev) window → In the script drop-down menu, select “54 AD-001: Import 

subvolume.” 
7. If there were multiple bones in a tube when scanned, refer to the sketch you should have made in Step 

7 of Section 1.3 Creating Your Bone-Agar Block(s) illustrating the position of the bones and the 

toothpick, and begin with the bone in position 1 for Step 8. First, on the right-hand region of the 

screen, click one of the thumbnail slices that clearly displays ALL of the bones in the sample. 

8. Once a thumbnail slice has been selected, on the left-hand region of the screen, adjust the VOI box 

around the bone of interest and ensure it fits around the same bone for ALL of the slices that are 

displayed on the right-hand portion of the screen (Figure 10). To do so, place your mouse cursor over 

any line of the box → click and hold the left mouse button → drag the box around the bone of interest 

→ release the left click once satisfied with the box’s placement. Crop the box as necessary to 

encapsulate ALL of the bone by holding left click on the squares of the VOI box and dragging them 

around. Refer to Figure 13 for a visual reference. 

If this VOI box contains bits of other bones by 

chance, it will not affect the subvolume script.  

  

Figure 10: Screenshot of thumbnail slices 
where a VOI box encapsulates a bone of 
interest for ALL of its slices 
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9. Locate the “Name or Number” box in the bottom-left corner of the “Tasks” tab, and change the name 

of the specimen to the lab’s name along with the bone name. Do NOT use dashes in the name. If you 

must, use spaces or underscores to separate names and numbers. 

READ STEPS 10 & 11 BEFORE CONTINUING! 
10. Click the “Start Task” button → click “OK” once the “Task submitted successfully” appears → click the 

“History…” button which loads the “Task History for Measurement [#]” window→ navigate to the “Job 

Queue” tab. If the “Status” is “Pending,” the task is in a queue and will automatically run when the 

script is ready. If the “Status” is green and states “Running,” the script is currently running on your 

measurement. When the “Status” changes to “Success,” the script has finished, and you may close out 

of this window. 
 

11. You may NOT move on to the next bone within the SAME measurement while a task is running, but 

you may move on to the next measurement number. For example, if there are multiple bones in the 

measurement (same tube) that require the Subvolume script, they must be done ONE AT A TIME; 

however, if the bones are split up into numerous measurements (multiple tubes), you may initiate the 

script and move on to the next measurement (next tube). 

 
12. Repeat the steps written above for EACH bone with respect to Step 11.  

 
13. Once all of the bones have been subvolumed, at the top of the window, click “Projects” → “Scan Group 

Members…” → on the right-hand side next to “To:” select your ScanGroup from the drop-down menu 

that was provided by the Lab Manager. 

 
14. Locate your scans in the left-hand column (usually toward the bottom) → hold the “Ctrl” key and left 

click on each scan (you may also use the scroll wheel to move up or down in this column) →  click “Add 

to [your scan group name]” at the bottom left-hand corner → “Close” out of this window. Now, your 

measurements have been added to your scan group, which allows for easier access to the data once 

the scans are analyzed. You may have to refresh this window to view any changes. 
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4.3 Identification of Epiphyseal Plate (12:38) 

15. To perform trabecular analysis, we must first identify the trabecular region of the bone. To do so, load 

your first measurement as explained in Section 4.1 Retrieving & Loading Your Scans and navigate to the 

“Tasks” tab, and click “OK” or the “Enter” key if a “Program Default Script” message appears.  

16. For trabecular analysis, it is recommended to evaluate a 1.5 mm length of the metaphysis. This length 

corresponds to approximately 150 slices at a 7.4 µm resolution directly adjacent to the epiphyseal 

growth plate. With that said, the first step in identifying the trabecular region is to locate the position 

of the growth plate.  

17. Look for the following progression illustrated in Figure 11: 
 
 
 
 

 
 
 

 

 

 

 

 

 

Figure 11: The 
progression of the 
growth plate 
disappearing to make 
way for the metaphyseal 
region. 
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As seen in the last image, on the far left, the growth plate can be identified by the four ovals that constitute the 

crown of the plate. As we approach the metaphyseal region (to the right), the ovals begin to merge, and the 

trabeculation in the bone progressively increases, as shown above. In the picture on the far right, we can 

observe a significant opening in the middle of the bone since the first picture—we denote this slice as the 

starting slice of the metaphyseal region. Identifying the starting slice can sometimes be challenging, and it will 

vary from user to user. Please seek the Lab Manager for additional assistance. 

18.  Load your first measurement as explained in Section 4.1 Retrieving & Loading and navigate to the 

“Tasks” tab, and click “OK” or the “Enter” key if a “Program Default Script” message appears.  

19. Depending in what direction your agar-bone block entered the specimen tube depends on whether the 

metaphyseal slice will appear at the beginning (near slice 1) or at the end (largest slice number) of the 

scan. If the agar-bone block entered the tube with the bones’ distal end first, then you will find your 

epiphyseal plate near the end of the scan (largest slice number). The opposite is true if the proximal 

end entered the tube first. 

20. On the right-hand side of the “Tasks” tab, click on the slice thumbnail that is near the metaphyseal 

region (slice values are in the top-left of each thumbnail). In the tutorial video AND this SOP, the 

metaphyseal region is located near the end of the scan. Hold left-click and drag the slider until the four 

crowns appear as shown in Figure 11 above. Use the left and right arrow keys to move one slice at a 

time and stop once you reach the epiphyseal plate start slice. Record this start slice value somewhere. 

 

 

21. Subtract 149 from the value recorded in Step 3 to acquire your trabecular analysis start slice. Repeat 

steps 1-4 for each measurement. *If your bones are oriented opposite to Step 19, use the slice value 

recorded in Step 20 as your trabecular analysis start slice. 

 

Figure 12: Screenshot of slider bar with the slice position box located on the “Tasks” tab. 
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4.4 Creating Trabecular Contours (13:26) 

22. Load your first measurement as explained in Section 4.1 Retrieving & Loading and navigate to the 

“Tasks” tab. Select the “10 BO-008: Autocontour Bone” script from the script drop-down in the bottom 

left region of the screen. 

23. Locate the slice position box on the right side of the screen, which should be directly left to the “Load” 

button (Figure 12). Enter the analysis start slice value (calculated in Step 21 previously) in the box and 

hit the “Enter” key, which should load the analysis start slice on the left-hand side of the screen.  

24. A VOI (Volume of Interest) box will appear over the bone. To adjust the VOI box around your bone, 

place your mouse cursor over any line of the box → click and hold the left mouse button → drag the 

box around the bone of interest → release the left click once satisfied with the box’s placement. Crop 

the box as necessary to encapsulate ALL of the bone by holding left click on the squares of the VOI box 

and dragging them around. Refer to Figure 13 for a visual reference. 

 
 
 
 
 
 
 
 
 
 
 
 
 

25. At the bottom left corner, locate the boxes next “Z:” and “dZ:” → enter the trabecular analysis start 
slice value in the “Z:” box and hit the “Enter” key on the keyboard→ enter 150 in the “dZ:” box and hit 
the “Enter” key on the keyboard → ensure the drop-down menu just under this area states 
“Trabecular” and NOT “Cortical.” 
 

 
 
 

 
 

Figure 13: Screenshot of VOI box 
encapsulating area of trabecular bone. 

Figure 14: Screenshot of “Z” and “dZ” 
boxes. 
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26. Ensure the VOI box fits around the bone for the entire 150-slice range. To do so, click the horizontal bar 

(not the slider) on the side of the slider in the direction of the metaphyseal start slice (usually toward 

the right). Each click will move the slider 10 slices toward the respective direction. For each click till you 

reach the metaphyseal start slice, ensure the VOI box fits around the bone by adjusting the VOI box as 

necessary. If the VOI box disappears after multiple clicks, you have moved beyond the 150-slice range. 

Additionally, if the VOI box disappears after your first click, the slider is moving in the opposite 

direction. 

27. Once the VOI box has completely encapsulated the bone for the 150-slice range, you are ready to run 

the Autocontour script. Click the “Start Task” button near the script drop-down menu → click “OK” 

once the “Task submitted successfully” appears → REPEAT Steps 1-5 for each/every measurement.  

28. If you’d like to view the queue and history for each task, click the “History…” button which loads the 

“Task History for Measurement [#]” window→ navigate to the “Job Queue” tab. If the “Status” is 

“Pending,” the task is in a queue and will automatically run when the script is ready. If the “Status” is 

green and states “Running,” the script is currently running on your measurement. When the “Status” 

changes to “Success,” the script has finished. (You can use the horizontal slider in the “Job Queue” tab 

to view the start and end times if you’d like to confirm your task has been completed).  

29. Once the Autocontour script has completed running for each measurement, ensure the contours were 

drawn properly for ALL measurements (this can either be done after the script has run for each 

measurement or after it has run for all the measurements).  

30. To do so, reload a measurement (start with the first and work your way toward the last measurement) 

→ navigate to the “Contouring” tab → click through the green boxes at the bottom of the screen while 

simultaneously checking the drawn contours on the left side of the screen. It is unnecessary to check 

every individual slice. You may use the 10-slice slider technique mentioned in Step 5 to speed up the 

process. *If the automatic contours are improperly drawn, please seek the Lab Manager.  

31. Please proceed to Section 7.2 Trabecular Thresholding. 
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4.5 Identification of Mid-Diaphysis (19:44) 

32. To perform cortical analysis, we must first identify the mid-diaphyseal region of the bone. If there is 

more than one bone in the scan, refer to the sketch you should have made in Step 7 of Section 1.3 

Creating Your Bone-Agar Block(s) illustrating the position of the bones and the toothpick, and begin 

with the bone in position 1.  

NOTE: The following instructions assume you scanned the entire bone length. If not, seek the Lab 

Manager. 

33. Load your first measurement as explained in Section 4.1 Retrieving & Loading and navigate to the 

“Tasks” tab, and click “OK” or the “Enter” key if a “Program Default Script” message appears.  

34. Record both your starting slice value (the first slice near the proximal end of the bone in which the 

smallest, prominent slice of bone appears on the scan) and your ending slice value (the last slice near 

the distal end of the bone in which the smallest, prominent slice of bone appears on the scan) for each 

measurement. Try to remain consistent with these choices for each bone. 

35. To do this, navigate to the “Contouring” tab of SCANCO’s “Ev” (Evaluation) window. By default, the 

slice bar is located at the first slice. Drag the slice slider to the right until the first bit of bone appears 

(start slice region), and move it all the way toward the end until the last bit of bone appears (end slice 

region). Record the appropriate values as described in the previous step. Refer to Figure 15 below for 

additional information. 

 
 
 
 
 
 
 
 
 

36. Next, obtain the difference between the larger value (typically the end slice) and the smaller value 

(typically the start slice) → divide by two to locate the midpoint slice → and add & subtract 25 slices 

from the midpoint value to create a cortical range. These boundaries are recognized as the starting and 

Figure 15: Screenshots of starting and 
ending slices of a bone that can be 
regarded as “prominent.” 
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ending of the cortical region of the midshaft. (ie. if the midpoint is 1069, the analysis starting and 

ending slices would be 1044 and 1094, respectively). Repeat Steps 5-8 for EACH measurement.  

*Note: This calculation assumes the entire bone was scanned. If not, please seek the Lab Manager. 

37. Please proceed to Section 7.3 Cortical Thresholding. 
 

4.6 Trabecular Analysis (17:35) 

38. Load your first measurement as explained in Section 4.1 Retrieving & Loading and click “OK” or the 

“Enter” key if a “Program Default Script” message appears.   

39. Navigate to the “Tasks” tab → ensure your custom trabecular analysis script is selected in the script 

drop-down menu (this will be repeated for each measurement). If you had the Lab Manager 

permanently adjust the lower threshold value to the one you calculated in Section 7.2 Trabecular 

Thresholding, double-check to ensure this value has been accounted for in the lower threshold box at 

the bottom middle of the screen. If this is not the case, enter your finalized lower threshold value → 

click the “Start Task” button → click “OK” once the “Task submitted successfully” appears → move on 

to the next measurement, and repeat this step for every measurement across the entire sample. 

 

40. If you’d like to view the job queue and history for each task, click the “History…” button, which loads the 

“Task History for Measurement [#]” window→ navigate to the “Job Queue” tab. If the “Status” is 

“Pending,” the task is in a queue and will automatically run when the script is ready. If the “Status” is 

green and states “Running,” the script is currently running on your measurement. When the “Status” 

changes to “Success,” the script has finished. (You can use the horizontal slider in the “Job Queue” tab 

to view the start and end times if you’d like to confirm your task has been completed). 
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4.7 Cortical Analysis (22:39) 

41. Load your first measurement as explained in Section 4.1 Retrieving & Loading and click “OK” or the 

“Enter” key if a “Program Default Script” message appears. Navigate to the “Tasks” tab. 

42. Ensure your custom cortical analysis script is selected in the script drop-down menu. If you had the Lab 

Manager permanently adjust the lower threshold value to the one you calculated in Section 7.3 

Cortical Thresholding, double-check to ensure this value has been accounted for in the lower threshold 

box at the bottom middle of the screen. If this is not the case, enter your finalized lower threshold 

value → click the “Start Task” button → click “OK” once the “Task submitted successfully” appears → 

move on to the next measurement, and repeat Steps 1 & 2 for every measurement across the entire 

sample. 

43. If you’d like to view the job queue and history for each task, click the “History…” button, which loads the 

“Task History for Measurement [#]” window→ navigate to the “Job Queue” tab. If the “Status” is 

“Pending,” the task is in a queue and will automatically run when the script is ready. If the “Status” is 

green and states “Running,” the script is currently running on your measurement. When the “Status” 

changes to “Success,” the script has finished. (You can use the horizontal slider in the “Job Queue” tab 

to view the start and end times if you’d like to confirm your task has been completed).  

CONGRATULATIONS! You have now completed the ENTIRE bone analysis process and may download and 
export your data. 
 

Section 5: Exporting Your Data 
 

5.1 Accessing Your Data (24:06) 

1. Using the same computer as your analysis, locate the “SCANCO Application Center.” At the top of this 

window, click “Tools” → “File Browser” → a new window named “SCANCO File Browser” should 

appear. 

2. Navigate to the “Projects” tab → locate and double left-click the “Results” folder within the list of 

folders present. If you have a measurement group (if you do not, skip this step), you will see your data 

folder in the “Results” folder. Double left-click on this folder and skip the next step to access your data. 
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3. If you have an evaluation group, your data folder will instead reside in the “All” folder, where one or 

more .csv files will be present. 

4. For measurement groups, your data will appear in the “Standard” folder, where one or more .csv files 

will be present. 

5. Because these files are stored on a server and NOT the computer’s hard drive, you must download the 

files you wish to export by right-clicking the file and clicking “Download.” A window to save your data 

will appear. 

6. On the left-hand side of this window, click on the "Downloads" folder. If you have multiple .csv files (or 

DICOMs for DICOM exporting), we recommend creating a custom folder within the "Downloads" folder 

to store data. To create the folder: right-click in the empty space → hover your mouse cursor over 

"New" → click on "Folder" → give the folder an appropriate name → save your .csv files inside it. Refer 

to Figure 16 below for help. *Note: Users shall only create ONE folder per experiment to store any 

data. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16: 
Screenshot 
illustrating the 
creation of a new 
folder to 
download and 
export data. 
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7. Now that your data is downloaded onto the computer, you can use the internet (Google Chrome, 

Microsoft Edge, etc.) to log into Box, Google Drive, Outlook Email, etc. to upload your data. Please see 

Section 5.3 Ways to View My Data for additional information. 

5.2 Exporting as a DICOM (25:08) 

8. Exporting CT scans as a DICOM requires users to run a specific script on their measurements. To do so, 

load the measurement that you wish to export as a DICOM as shown in Section 4.1 Retrieving & 

Loading Your Scans → navigate to the “Tasks” tab.  

9. Select the “24 EX-003: Convert to DICOM” script from the script drop-down menu located at the 

bottom right region of the “Tasks” tab → ensure the ZIP settings, located under the script drop-down 

menu, are identical to Figure 17, which has been standardized for DICOM exports → select the “Start 

Task” button and click “OK” once  “Task submitted successfully” appears. *Each measurement has a 

specific scan number, which is displayed in the window title “SCANCO Evaluation # / # / scan number 

/…” Record this number down as it must be used to identify your DICOM file(s) upon retrieval. 

10. Review Step 43 from Section 4.7 Cortical Analysis (Job Queue/History). Please move on to the next 

measurement and repeat steps 8-10 for each measurement that must be converted to a DICOM. 

11. The process of accessing the DICOM stored database is similar to Section 5.1 Accessing Your Data. To 

access your DICOM data: locate the “SCANCO Application Center” → at the top of this window, click 

“Tools” → “File Browser” → a new window named “SCANCO File Browser” should appear. 

12. Navigate to the “Projects” tab → locate and double left-click the “export” folder → find your custom 

DICOMs and follow Steps 5-7 of Section 5.1 Accessing Your Data. 

Figure 17: Screenshot of standardized ZIP settings for DICOM exports. 
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5.3 Ways to View My Data 

1. Two of the best ways to view your .csv data are Microsoft Excel or Google Sheets, which provide a 
better-looking view.  

a. Excel: Start by right-clicking your .csv file, hovering over “Open with”, and clicking “Microsoft 
Excel.” 

b. Sheets: Search https://docs.google.com/spreadsheets/u/0/ in your browser and create a blank 
spreadsheet. Click “File” and then click “Import.” If you have saved your .csv file(s) to your 
Google Drive account, you can search for it here. Otherwise, you must upload the .csv file(s) 
using the “Upload” tab and clicking the blue “Browse” button.  

2. You can also view your data with Notepad and other similar programs by right-clicking your .csv file, 
hovering over “Open with,” and clicking “Notepad.” 

 
***Note: Please refer to Understanding uCT Outcomes, which can also be found in the “Technical Notes & 
Presentations” tab on WashU’s MRC website, to aid with data analysis. 
  

https://docs.google.com/spreadsheets/u/0/
https://bpb-us-w2.wpmucdn.com/sites.wustl.edu/dist/f/1982/files/2021/07/Understanding-uCT-outcomes2021.pdf
https://musculoskeletal.wustl.edu/cores/core-b/notes/
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Section 6: Generation of 3D Images 
 

6.1 Displaying a 3D Object (26:44) 

Use the following steps if a script has already run on the image of interest: 
1. Find a “µCT50 Analysis Computer” and navigate to SCANCO’s Application Center. Click on the “RT” 

button to launch the RayTracer application and wait until the “Select Sample and Measurement…” 

window appears. If this window does not appear, click “File” and “Open…” 

2. Select your sample by scrolling through the list or searching by filtration. At the middle bottom of the 

screen, ensure the “All Files” bubble has been clicked. Under “Measurement,” select the desired 

measurement you’d like to view in 3D (instructions provided in the next step). 

3. Locate a file with an extension name of “cort_seg.aim” (cortical) or “trab_seg.aim” (cancellous) under 

the appropriate measurement number (Figure 17). Double left-click on the file of interest and click 

“Start” in the bottom left-hand corner to load the 3D image. Please wait until the image has fully 

loaded BEFORE exporting or altering the image (blue loading circle returns to the white mouse cursor). 

Please see 6.2 Orienting a 3D Object for information regarding how to edit the orientation of your 3D 

image. 

  

Figure 18: Screenshot of “Select Sample and Measurement…” window depicting a measurement 
and cortical segmentation selection for 3D viewing. 
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Use the following steps if a script has NOT already run on the image of interest: 

4. Load a measurement as explained in Section 4.1 Retrieving & Loading that you’d like to view as a 3D 

image and click “OK” or the “Enter” key if a “Program Default Script” message appears.  

5. Under the “Contouring” tab, “Clear All” contours → create a contour by creating a shape (usually an 

ellipse or circle) around a bone of interest at a specific starting slice value. If your drawn contour is 

slightly off, click “Select,” which will allow you to drag the VOI box and the contour → copy (Ctrl + C) 

the contour and paste (Ctrl + V) it at an ending slice value (this creates a slice range). Again, adjust the 

contour as necessary to fit around your bone of interest. Please see Figure 18 for help. 

 
 
 
 
 
 
 
 
 
 

6. A wider range between the starting and ending slice values increases the likelihood of the contour not 

fitting around the desired bone when morphing the contour from start to finish. To avoid this, it is 

recommended to select slice values within the range and use the "Select" tool to adjust the contour, 

ensuring it properly encompasses the bone of interest. For instance, if the slice range is 1500, we 

recommend choosing 10 evenly spaced slices for contour adjustments. Seek the Lab Manager for more 

help. 

7. Once your contours are finalized, under the “Morphing” section → select the drop-down arrow next to 

“Morph Range” → select “Morph All.” Check a few slices in your slice range to ensure the morphing 

process has accurately placed your contours around the bone of interest. If not, repeat Step 6 and 

adjust the placements of more contours at different slices in the slice range to increase morphing 

accuracy. 

8. Click on the “Tasks” tab, and select the script “11 IP-001: Segmentation of 1 phase/object.” At the 

bottom middle of the same screen, change “Permile” to “Density.” 

  

Figure 19: Screenshot of “Edit” & “Morphing” 
boxes for contour creation and morphing. The 
“Select” and “Circle” tools are also shown. 
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9. Adjust the lower threshold value as necessary by switching between the mask  and the image . 
(This step is optional). 

10. Once satisfied, at the top-left of the window, click “File” → “Save Contour as” → click the .gobj file 

under “Missing / Required by selected task” → click “Save.” You are now ready to run the script: “11 

IP-001: Segmentation of 1 phase/object.” Click “Start Task.” to initiate the task → Click “OK” on “Task 

Submitted successfully” → click the “History” button to load the “History” window, and navigate to the 

“Job Queue” tab. Once the “Status” shows the task is complete, move on to the next step. 

11. Once complete, on the “SCANCO Application Center,” click on the “RT” button to launch the RayTracer 

application. Follow steps 2 & 3 from 6.1 Displaying a 3D Object, but ensure “Segmented” is clicked 

instead of “All Files.” 

6.2 Orienting a 3D Object (27:26) 

12. If you’d like to enlarge the image, you can do so by first, increasing the window size by clicking the box 

in the top right-hand corner of the window, and second, increasing the scale factor. 

13. Additionally, by clicking “Subdim” followed by “Subdim…” at the top of the window, you can open your 

image to cut and view bone slices along different axes. Once you're satisfied with the bone's 

orientation, click the “Start” button in the bottom left-hand corner or the blue screen. (Changes to the 

image may occur automatically). 

14. We encourage users to play around with the sliders to better understand the function of each slider. A 

short description of these functions appears in the commonly asked questions handbook, which is 

located above Analysis Computer 2. 

6.3 Exporting a 3D Object (31:06) 

15. First, have the image open as explained in either part of 6.1 Displaying a 3D Object. Once the image 

has completely loaded (the blue loading circle morphs back into the usual mouse cursor), at the top 

left-hand corner of the window, click “File” → “Print” → select “TIFF” and “Scratch/Temp.” You may 

change the filename if you desire to do so. The directory where this image will save will appear similar 

to “C:\Users\scanco_user\filename\...” 

16. Record this directory such that it can be located to download the 3D image. Once downloaded, you 

may upload this file to Box, Google Drive, Outlook, etc. 
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17. To view another image after completing this process, return to the “SCANCO RayTracer” window → 

“File” → “Open…” → and select the next measurement you’d like to view. 

 

Section 7: Choosing Evaluation Thresholds 
 
7.1 Threshold Description 
During the analysis, evaluation script thresholds determine which voxels in your scan are classified as bone. 

These thresholds play a crucial role in calculating parameters such as trabecular thickness, bone area, and 
volume. Unlike contour thresholds, evaluation thresholds must remain consistent across all measurements in 

the analysis. Therefore, it is crucial to select threshold values that align favorably with ALL samples, rather 

than relying on a single measurement. This is done by adjusting the lower threshold value and comparing a 
gray scaled mask with the original bone. A lower threshold value can be determined once the mask is close to 

the shape of the original image. *Note: Please refrain from modifying the finalized threshold valued during the 

experiment. 
 
7.2 Trabecular Thresholding (16:04) 

1. Once the automatic trabecular contours have been drawn and checked, you may now look to acquire 

the appropriate lower threshold value. To do so, re-load your first measurement →  navigate to the 

“Tasks” tab → select your custom script (provided by the Lab Manager) in the script drop-down menu 

(bottom left region of the screen) → load any slice within the 150-slice range (green contour should be 

drawn) using the method described in Step 23 of Section 4.4 Creating Trabecular Contours.  

2. At the bottom middle of the screen, there exists a lower threshold box, which is located to the right of 

a slider named “Lower:”. Adjust the lower threshold value in the box as necessary by switching 

between the mask (or “F5” key) and the image  (“F6” key) to determine the best value 

(increasing the lower threshold decreases the mask’s area). Once the mask appears as close to the 

original bone as possible, record the lower threshold value. Refer to Figure 19 for help regarding what 

is considered a “good” lower threshold value, and please seek the Lab Manager if you are experiencing 

difficulties. 
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3. Repeat Steps 1 & 2 for three to four measurements of each experimental group (control, knock-out, 

drug, no-drug, male, female, etc.) when determining a threshold value for your experiment → find the 

mean (average) of the lower threshold values → use this new finalized lower threshold value when 

running any trabecular analysis script. If you’d rather have the finalized lower threshold permanently 

updated in your custom script for each run during the analysis (usually users must re-enter this value 

for each run/measurement), please inform the Lab Manager.   

4. No threshold will be perfect for every group, but the mean threshold value should be somewhat 

appropriate for each group. This threshold value will not change during your experiment. If your 

experimental groups are unique enough that a “good” mean threshold value cannot be determined, 

please consult the Lab Manager. Please return to Section 4.6 Trabecular Analysis as you are now 

ready to begin the analysis. 

 

 
 
 
 
 
 
 
 
 
 
7.3 Cortical Thresholding (20:51) 

1. Load your first measurement as explained in Section 4.1 Retrieving & Loading and click “OK” or the 

“Enter” key if a “Program Default Script” message appears. Navigate to the “Tasks” tab. 

2. Ensure a script is selected from the script drop-down menu → enter the cortical analysis start slice next 

to the “Z:” box located in the bottom left region of the screen → hit the “Enter” key on the keyboard → 

enter 51 in the “dZ:” box located just beside “Z:” → hit the “Enter” key on the keyboard. 

  

Figure 20: Screenshots of using grayscale thresholding for a femur metaphysis from Kim Y, Brodt MD, 
Tang SY, Silva MJ. MicroCT for Scanning and Analysis of Mouse Bones. Methods Mol Biol. 
2021;2230:169-198. doi: 10.1007/978-1-0716-1028-2_11. PMID: 33197015; PMCID: PMC8409170. 
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3. Load the analysis start slice by entering it in the slice position box and hitting the “Enter” key on the 

keyboard. The slice position box is located in the bottom right region of the screen next to the “Load” 

button (Figure 12). On the left side of the screen, adjust the VOI box to encapsulate the cortical bone 

as described in Step 24 of Section 4.4 Creating Trabecular Contours → locate the lower threshold box 

at the bottom middle of the screen, which is located to the right of a slider named “Lower:” → adjust 

the lower threshold value in the box as necessary by switching between the mask (or “F5” key) 

and the image  (“F6” key) to determine the best value (increasing the lower threshold decreases 

the mask’s area).  

4. Once the mask appears as close to the original bone as possible, record the lower threshold value and 

compare it to another slice within the 50-slice range. If this lower threshold is “good,” record this value 

down. Refer to Figure 20 below for help regarding what is considered a “good” lower threshold value, 

and please seek the Lab Manager if you are experiencing difficulties. 

 

 

 

 

 

  

Figure 21: Depicts ideal lower threshold value between mask (left) and preview (right) images. 
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5. Repeat Steps 1-4 for three to four measurements of each experimental group (control, knock-out, 

drug, no-drug, male, female, etc.) when determining a threshold value for your experiment → find the 

mean (average) of the lower threshold values → use this new finalized lower threshold value when 

running any cortical analysis script. If you’d rather have the finalized lower threshold permanently 

updated in your custom script for each run during the analysis (usually users must re-enter this value 

for each run/measurement), please inform the Lab Manager.   

6. No threshold will be perfect for every group, but the mean threshold value should be somewhat 

appropriate for each group. This threshold value will not change during your experiment. If your 

experimental groups are unique enough that a “good” mean threshold value cannot be determined, 

please consult the Lab Manager. Please return to Section 4.7 Cortical Analysis as you are now ready 

to begin the analysis. 

 

Section 8: Change Logs 
 

Name and Date Change(s) 

Anish J. | 7/31/2023 Updated TOC and video timestamps throughout document. Minor 
changes to SOP including the Notes section. 

  

  

  

  

 
 
DISCLAIMER: This Standard Operating Procedure (SOP) directly correlates to the machinery and software that 
is available at the Musculoskeletal Research Center at Washington University in St. Louis. If you are NOT using 
the equipment provided at this center, please proceed with caution BEFORE attempting to use a microCT for 
mice bone scanning and analysis. 
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